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Precautions for use 
Please be sure to read and follow the instructions below for safe use. 

 

Intended use: BB-L3 is intended for laser marking 
 

 The instructions below are intended to prevent personal injury and property damages. 

 Please read carefully and use the machine properly. 

 
If you do not follow these instructions, injury or property damage may occur. 

 
If you do not follow these instructions, users may be seriously injured. 

 

 Precautions related to power 

 

Do not use damaged cord or loosened outlet.   

 It may cause electric shock or fire.  

Do not put multiple power plugs into 

one inlet simultaneously. It may cause 

fire due to overheated inlet. 

 

Do not pull a plug by the cord. Do not touch 

a power plug with wet hands.  

When the machine is not in use for a 

long period of time, pull out the power 

plug. 

 

If smoke comes out from the machine during 

use, turn off the machine immediately and 

call the dealer or our service center.   

Plug-in the provided power cable only to 

the grounded outlet (power mains). 

If the outlet (power mains) is not 

ground-wired, set the grounding 

separately. 

 Precautions related to use 

 

Do not use this machine in a place with oil, 

smoke, moisture, dust or water.  

 It may cause electric shock or fire.  

Do not put a candle or cigarette button 

the machine. Avoid any heating 

apparatus like heater when using this 

machine. 

 It may cause failure or fire due to 

overheating. 

 

Be sure to place the machine body only on a 

stable level surface. 
 

Be sure not to be caught or jammed 

between the paths of each axis of the 

machine. 

 

When temperature falls below freezing point, 

the machine may not work properly. In this 

case, please sustain the room temperature in 

the place where you use this machine for 

normal operation. Please make sure the 

temperature in the place where you use the 

does not fall below the freezing point. 

 

Do not put water or small metal 

materials on the machine.  

 Due to negligence or vibration of 

the machine, the materials may fall 

and cause injury, fire or failure by 

overheating or short circuiting. 

 If water gets into the machine, it 

may cause electric shock or fire. 

 

Do not disassemble or modify the machine.  

 It may cause fire, electric shock or failure. 

Please contact the dealer or our service 

center for inspection, calibration and 

repair. 

 

Performance and quality of marking and 

cutting may vary depending on 

materials such as highly reflective 

materials (silver). 

 

We will not be held responsible for damage 

caused to machine by misuse or poor care.   

Be sure to keep out of the reach of 

toddlers and children. Their curiosity or 

carelessness may cause injury. 
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Precautions on laser machines  

` 

 

The tests carried out demonstrate the safety and reliability of the laser when it is used properly.  

However, the operator must be aware of the precautionary regulations aimed at avoiding possible harm to 

people or damage to the equipment itself. 

 

Incorrect application of the safety regulations during the practical use of the machine described in 

this manual can lead the user to harmful exposure to laser radiation. 

Follow the procedures carefully. RED Technology Co.,LTD declines all liability for damage caused by 

negligence in applying the indicated safety regulations. 
 

 

 

The control and operation of the laser generator (CLASS 4) in a way other than its 

intended purpose may result in the exposure of dangerous laser radiation.  

Be careful that if a body part (e.g., eyes, skin, etc.) is exposed to such laser radiation, you 

could suffer serious damage. 

 

Class IV lasers generate risks not only by direct or reflected radiation but also by diffused 

radiation. These laser sources can pose a significant hazard for the skin and the risk of fire 

of inflammable materials. For these reasons, the user must establish all radiation 

containment measures to ensure that it is terminated at the end of its useful process. 

Furthermore, the operator must be informed of the risks from exposure to laser 

radiation and must be equipped with the appropriate PPE (personal protective 

equipment), which consists of certified protective goggles against laser radiation. 

 

 

 

Make sure that you are not exposed to the laser directly. It may result in 

blindness. Do not stare at the specular/diffuse reflection of laser without 

personal protective equipment. 

 

 

<RADIATION VIEWING CONDITIONS> 

The laser output by the resonator is to be considered a highly collimated and intense 

monochromatic light source. Thanks to these characteristics it can be considered a very 
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bright “point source”. This means that its “image” is then focalized on the Retina in a very 

small spot with dangerously high power density! If, on the other hand, the beam 

becomes divergent and scatters to a non-reflecting screen, there then will be an 

“extended viewing” of the image, with a significantly less dangerous power density. 

Therefore, different types of radiation viewing can be distinguished in relation to how the 

radiation itself can be accessed and consequently, different degrees of risk. 

 

● Direct viewing of the laser beam 

This type of viewing is the most dangerous and can occur at the outlet of the laser 

aperture, after removing the lenses. It must be avoided in every way! No protective 

goggles can be considered a valid means against direct viewing of the beam. 

 

● Direct viewing of the beam after mirror reflection 

This can occur by directing the beam on a reflective surface. Viewing a mirror reflected 

beam on a flat surface is extremely dangerous, just like direct viewing. 

 

● Direct viewing of the beam at the output of an Optical fiber 

Connecting the Optical fiber from the resonator. Viewing the beam is dangerous up to a 

significant distance. Filters and goggles cannot guarantee safety. 

 

● Viewing the beam directly after focusing 

This occurs if the laser beam is not extinguished on a suitable absorber at the end of its 

useful path. Viewing the beam is dangerous up to a significant distance. Filters and 

protective goggles can guarantee safety for brief exposure, as long as they are the right 

size and certified. 

 

● Scattered viewing of the Laser beam after focusing 

This is the most common viewing condition for equipment in an operative setting. 

Viewing the beam is not dangerous if not at a short distance, but adequate filters and 

Goggles can guarantee safety, even for long exposure. 

 

 

Do not stare at the specular/diffuse reflection of laser.  It may result in 

blindness.  

 

Radiation is invisible however; being close to the visibility threshold causes the eye to 

receive it almost entirely with no pupillary reflex. If we add that it is generally very intense, 

it can be extremely harmful or lethal for the vision. 

Certain precautions must be followed so as to avoid permanent personal injury. 

All people who may be exposed to harmful laser radiation levels must know when the 

laser is active, and if so, they must wear protective eyewear. 

Due to the high power, the laser integrated in the machine causes laser light to be 

reflected by flat surfaces. Reflected light is potentially dangerous to the eyes and skin. The 

electromagnetic emission with micrometric wavelength is located in the far infrared and 

is therefore invisible, so it is not clear where the reflected beams are directed. 

 

● CAUTION: Direct viewing of a laser beam can cause irreversible damage to the eye. 

 

● CAUTION: It is essential to protect yourself from the beams of reflected light because 

they can be sufficiently intense to cause permanent damage to the eyes or skin. 

 

● CAUTION: The laser in question falls under class IV. Class IV lasers generate risks not 

only by direct or reflected radiation but also by diffused radiation. These laser sources 

can pose a significant hazard for the skin and the risk of fire of inflammable materials. 
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Make sure that your body part is not in the operating range. It may result in skin damage 

such as burns.  

 

If subjected to intense laser radiation, even for a brief duration, or to less intense but long 

lasting radiation, both the cornea and the retina can burn and be irreparably damaged. 

This consequence is quite realistic in the case of direct viewing a class IV Laser beam. 

If subjected to direct focalized radiation, even the skin can burn. Furthermore, it must be 

considered that collateral radiation can coexist with the main radiation in the ultraviolet: 

long exposure can cause skin carcinoma. 

 

Do not use the machine for purposes other than those intended.  

Otherwise, you could be damaged by laser radiation. 

 

Appoint a laser safety manager and have him keep monitoring a laser risk and fully 

understand safety measures. According to each country’s laws, the safety measures for 

the class-4 laser system are mandatory. 

(During machine maintenance and control, make sure that the laser radiation is stopped, 

and safety goggles are put on. The eye/skin exposure to laser radiation can result in 

serious damage.) 

 

In order not to reduce the safety level of the equipment, the User must adopt conforming 

behavior and in the best possible safe conditions. Therefore, the need arises to develop a 

Standard Operating Procedure (SOP) in relation to the maneuvers to be carried out for 

commissioning and decommissioning the equipment. This procedure, which is illustrated 

near the installation, must be used as a reference for the Operator and will be written in 

their own language. 

Personnel training will be essential, which must be aimed at: 

● Familiarizing with the operating procedures of the system. 

● Knowledge of the biological effects of radiation on Eyes and Skin 

● Understanding the need for Personal Protective Equipment (PPE) 

 

If you wear a pacemaker, do not come near the machine or work area.  

It generates electromagnetic waves and can cause malfunction to the heart rhythm 

device. 

 

 

NEVER dismantle or remodel the machine randomly.  

Otherwise, you could be exposed to laser radiation and suffer eye/skin damage. In 

addition, exposure to a high-voltage part can result in an electric shock. 

An additional risk may be posed by a fire outbreak from processing materials other than 

those for which the equipment is intended. 

 

● CAUTION: If the intended use of the source is changed, for example for material 

process applications, collateral risks may arise due to fumes and vapors 

being generated which may be irritating or toxic if not removed and filtered 

properly before releasing them back into the environment. 

 

● CAUTION: Since there is a risk of fire when processing flammable materials, it is 

essential to follow the instructions provided by the manufacturer when 

commissioning the machine. 

 

● CAUTION: Do not subject material to the laser radiation other than what the  

equipment was built for. 
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Electricity is certainly the most serious collateral risk associated with a laser device, which 

may also be fatal. This can arise when the warnings and procedures imposed by the 

equipment manufacturer are not observed. Unauthorized and inexperienced personnel 

must never carry out any type of intervention on the electrical part. The safety devices 

must never be removed and their efficiency must be checked regularly. 

 

● CAUTION: Do not modify the electrical part unless you are an expert.  

Do not remove the protective devices. 

 

● CAUTION: When processing flammable materials, it is essential to follow the  

instructions provided by the manufacturer when commissioning  

the machine. 

 

 

 

Make sure that you have a system which emits the dust and haze which are generated 

during operation. The warranty does not cover the system damage or failure resulting 

from corrosive haze. 

 

If, for example, during the processing in the intended use of the Laser source, the 

material is subjected to alterations and produces irritating and/or toxic fumes or vapors, 

these must be removed and filtered before releasing them back into the environment. 

 

An additional risk may be posed by a fire outbreak from processing materials other than 

those for which the equipment is intended. 

 

● CAUTION: Do not subject material to the laser radiation other than what the  

equipment was built for. 

 

● CAUTION: Since there is a risk of fire when processing flammable materials,  

such as plastics, it is essential to follow the instructions provided by  

the manufacturer when commissioning the machine. 

 

If any defect is found, do not use the machine  

and contact the Service Center (+82-70-7011-0905) or seller. 

 

<Safety Labels> 
 

The laser system has seals in some points. For no reason whatsoever must the seals be broken or removed.  

The sealed parts, in fact, can only and exclusively be opened by the manufacturer. 

Labels and plates must not be removed or damaged. For any replacements, contact the seller or the 

manufacturer. 

 

Breaking or removing seals affixed to the laser system by the manufacturer immediately renders the warranty 

on the entire laser system null and void. 
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<Warning Labels> 
 

This label indicates that the operator must be informed of the risks from exposure to laser radiation and 

must be equipped with the appropriate PPE (personal protective equipment), which consists of certified 

protective goggles against laser radiation. 

   
 

 

This label indicates the presence of the laser without specifying the class it belongs to.  

    
 

This label indicates the presence of the laser, specifying the class it belongs to. 

 <In Program> 

 

<For your safety> 
 

Carefully read the warnings in this section before using the laser machine. Make sure that all warnings and 

instructions displayed on the machine are observed. The following warnings are indicated to ensure our 

machines are used safely and to prevent damage or injury to operators or other persons. 

Make sure that you have taken all the precautions indicated in the manual; all precautions are important for 

personal and work safety. 

 

THE LASER MACHINE CAN BE DANGEROUS 

Protect yourself and others from potential serious injury or death. Always wear protective eyewear. Keep 

children away from the machine. Persons with pacemakers must stay away from the machine, unless they 

have specific medical permission. Operators may be exposed to certain risks when using lasers. Laser 

machine is safe if the necessary precautions are adopted. Risks related to marking are limited to handling 

manufactured machines. The process itself is extremely safe. In any case, it is important to delegate 
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machine use only to authorized personnel. The installation, maintenance and repairs of the machine must be 

delegated to manufacture personnel or to its authorized engineers. 

 

ELECTRICAL DISCHARGES CAN BE FATAL 

Contact with live electrical parts can have fatal consequences or cause severe burns. Incorrect installation or 

grounding the machine can be dangerous. 

● Do not touch live parts. Remove the power cable from the power socket before installing or performing 

maintenance on the machine. 

● Install and ground the machine properly, in accordance with the user manual and in full compliance with 

local regulations and standards. 

● Turn the machine off after use. 

● Do not use cables that are weak or damaged, with an insufficient section or poorly connected. 

● Make sure the cables are positioned away from sources of heat. 

● Use the device only if it is in perfect condition. Make sure that the damaged parts are immediately  

repaired or replaced. 

● Make sure that all the cover panels remain fixed and in place. 

 

SWITCH THE MACHINE OFF IMMEDIATELY IN CASE OF MALFUNCTIONING 

If smoke or unusual odors are emitted from the equipment, immediately unplug the power cable, while 

taking care to prevent burns or damage. Continuous use of the laser machine in such conditions can cause 

serious injury and/or damage. The device must only be examined by manufacture technical personnel or by 

their authorized engineers. 

 

DO NOT ATTEMPT TO DISMANTLE THE EQUIPMENT 

The internal components of the device can cause injury. If the machine malfunctions, it must only be 

repaired by skilled manufacture personnel. 

 

DO NOT USE IN THE PRESENCE OF FLAMMABLE GAS 

Prevent the risk of explosion or fire by not using the equipment in environments saturated with flammable 

gas with minimal ventilation. Always keep a fire extinguisher nearby. 

 

FUMES AND GAS CAN BE HAZARDOUS TO HEALTH 

The laser processes produce fumes and gas. Inhaling these can be dangerous to human health. 

● Keep your head away from the fumes. Do not inhale the fumes. 

● Do not cover any part of the machine. 

● Carefully read the instructions for the various types of materials that can be laser welded. 

● It is preferable to use a large room specifically designed for the equipment to be used. If the room is 

small, make sure it is well ventilated. 

● Do not weld near degreasing, cleaning or steaming areas. The heat can react with the vapors, 

thereby producing very toxic and irritating gas. 

● Make sure the materials used do not contain impurities that could produce fumes or gas during laser 

marking. 

 

LASER CAN GENERATE A FIRE OR EXPLOSION 

Sparks and overheating can be generated during the processing of the marking materials and cause a fire 

and/or burns. Accidental contact of the overheated parts with the gas cylinder could cause an explosion. 

● Do not laser weld where the sparks could come into contact with flammable material. 

● Remove all flammable objects found near the laser machine. If this is not possible, cover them correctly 

with flame retardant material. 

● It is important to be aware of the risks of fire: always keep a fire extinguisher nearby. 

● Actively supervise the machine during operation. 



10 

LASER RADIATION CAN CAUSE INJURIES TO THE RETINA AND BURNS TO THE SKIN 

Uncontrolled reflections of the LASER beam can cause burns or, in the worst case, irreversible damage to the 

retina. Never weld on reflective objects. Keep children away when using the equipment. 

 

Reproduction, transmission, transcription, insertion into a data recovery system, translation into any 

language, in any form and by any means, is strictly prohibited without prior authorization. RED Technology 

Co., LTD reserves the right to modify the hardware and software information in this manual at any time 

without notice. RED Technology Co., LTD declines all liability for any kind of damage caused by using this 

machine. Despite our attempt to make sure this documentation is as complete and accurate as possible, we 

kindly ask you to immediately inform RED Technology Co., LTD of any errors or omissions. 

 

<WASTE SEPARATION> 
 

This machine must be disposed of in special waste containers. 

The following instructions are intended exclusively for cases where the equipment is 

used in European countries: 

● This machine must be disposed of in special waste containers. Do not dispose of 

with household waste. 

● For further information, please contact the local authorities responsible for waste 

disposal. 
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* For safe operations (Laser Class 1 Safety), 

Stay alert all the time when using the laser system.* 
 

 

Laser generator specifications 
 

This machine uses a laser generator. In accordance with IEC60825-1, JIS C6802 and FDA(CDRH) Part 

1040.10, CLASS 4 was adopted.  
 

- CLASS 4: Approach to laser is very dangerous to the eyes and skin. An emitting laser may cause  

fire or explosion. 
 

Type Ytterbium Doped Fiber Laser 

Model BB-L3-20W BB-L3-30W BB-L3-60W BB-L3-100W 

Output 20W 30W 60W 100W 

M² <1.5 <1.8 

Maximum Pulse Energy 0.8mJ 1.5mJ 

Pulse Repetition Rate 

Range 
25~600 KHz 37~600 KHz 1~4,000 KHz 

Pulse Width 200ns 200ns 2~500ns 

Speed Range 4,000mm/s 

Wavelength 1,064nm 

Output Beam Diameter 7.0±0.5mm 

Cooling Method Air-cooled 

Polarization Random 

Anti-Reflection Protection Yes 

Built-in Guide Laser Yes 

Class (Main Source) Class 4 

Power Supply Voltage 24VDC 48VDC 

Dimension (mm) 245x200x65 325x260x75 350x280x112 
 

 

In addition the red laser ‘CLASS 2’ is used as a guide laser. 

 

- CLASS 2: A Class 2 laser is relatively weak. It normally would not harm an eye unless a person deliberately 

stared into the beam. Laser protective eyewear is normally not necessary. A Class 2 laser is not a 

skin or materials burn hazard. However, even a Class 2 laser can be a distraction, glare or flash 

blindness hazard for pilots and drivers. NEVER aim any laser towards an aircraft or vehicle that is 

in motion.  

 
 

Class Class 2 

Output <1mW 

Wavelength 650nm 
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Laser Range 
If a body part or flammable material comes into the range of laser radiation, it may result in eye/skin damage 

or fire. Cover it with a proper shield which has decent reflection and thermal properties considering the risk 

of such range.  

(The marked distance represents the maximum width. It may differ from actual values.) 
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BB-L3 
1. Contents of the box 
The BB-L3 provides the following accessories.  

Their composition may differ depending on the options.  
 

Name Picture Quantity Usage 

BB-L3 

 

1EA Laser marking machine 

Power Cable 

 

1EA 

Power supply 

※ Use the power cable connected to the 

grounded outlet. Unless the outlet is 

grounded, separately ground the machine. 

USB Cable 

 

1EA PC connection 

Program 

Installation USB  1EA 
Design & marking software installation 

USB 

User Manual 
 

1EA Operating manual 

Clamp 

Set 

Clamp 

 

1SET Position support 

Clamp 

Bolt (M5-

12mm) 
 4EA For holding materials in place. 

L-wrench 

(4mm)  
1EA Tool for tightening/replacement of bolt. 

L-wrench 

(3mm)  1EA Tool for setting the focus pointer. 

L-wrench 

(2mm)  1EA Tool for setting the focus pointer. 

Ruler  1EA  

Clamp Pin (6Ø)  2EA For holding an optional clamp in place. 

Back port cover 

 

1EA 

For protecting the material from 

scratches. 

※ Use the power cable (Right angled) and 

USB cable (Left angled). 
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* Optional (Purchased separately) 
 

Power Cable 

(Right angled) 
 

1EA 

Power supply 

※ Use the power cable connected to the 

grounded outlet. Unless the outlet is 

grounded, separately ground the machine. 

USB Extension Cable 

(Left angled) 

 

1EA PC connection 

Medal 

Clamp Set 

Medal 

Clamp 
 

1EA 
For holding a variety of shape of 

materials in place. 

Pin  6EA For holding of irregular shaped material. 

Medal 

Clamp Set 

(Center fixing 

type) 

Medal 

Clamp 

(Center 

fixing type)  

1EA 
For holding a variety of shape of 

materials in place. 

Pin 
 

6EA For holding of irregular shaped material. 

L type clamp 

 

1EA 
For holding a variety of shape of 

materials in place. 

Rotary Clamp 

Set 

Chuck Handle  2EA 

-Rotary clamp-tightening handle 

- External device fine adjustment knob 

controlling handle 

Chuck Finger 

(4mm) 
 

3EA 
For holding rings when marking thin 

ring’s inner/outer diameter 

Chuck Finger 

(2mm) 
 

3EA 
For holding thin rings when marking thin 

ring’s inner/outer diameter 

Finger Skin 
 

1SET For protect chuck fingers. 

Finger 

Spanner  
1EA Tool for tightening chuck fingers. 

Auto Tilt 

Rotary Clamp 

 

1EA 
For holding ring materials in place. 

* 4mm chuck finger is included. 

Anti-drop 

pin (6Ø) 

(18mm) 
 1EA For preventing clamp falling. 

Honeycomb 

Table Set 

Honeycomb 

Table 
 

1EA 
For holding materials in place for cutting 

process. 
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Honeycomb 

Table Tray 
 

1EA Tray for Honeycomb Table  

Anti-Curling Clamp 

 
1EA For holding a thin plate in place. 

Blower 

Set 

Blower 
 

1EA Dust & smoke discharge 

Blower Hose 

(100Ø)  
2EA Blower connection hose (2.5M) 

Hose clamp 

(4inch)  
3EA 

For connecting to blower and hose. 

※ Please be careful of the cut surface of the hose 

clamp as it may cause injury.  

Auxiliary Power 

Device 

Set 

Auxiliary 

Power Device  
1EA 

Auxiliary power device is required when 

using the dust collector. 

Power cable 

 
2EA 

Supplies power and connects to the 

machine. 

 

※There may be parts not homologous with the manual. 

  



16 

2. Specifications 
 

 

Model BB-L3-20W BB-L3-30W BB-L3-60W BB-L3-100W 

Laser safety classification Class 1 

Dimensions 
404 mm(W) x 590 mm(D) x 556 mm(H)  /  

16 in(W) x 23 in(D) x 22 in(H) 

Max.engraving area 110mm x 110mm / 4.3in x 4.3in 

Maximum material height 100mm / 3.94in 

Maximum Z-axis height 100mm / 3.94in 

Effective space  

inside the chamber 

350 mm(W) x 170 mm(D) x 100 mm(H)  /  

13.7 in(W) x 6.6 in(D) x 3.9 in(H) 

Safety cover height  

(When open) 
266 mm / 10.4 in (From base plate) 

Maximum material weight 20kg 

Weight 45kg 46kg 50kg 54kg 

Power consumption 290W 340W 520W 730W 

Cooling system Air-cooling type 

Frequency 50/60Hz 

Operating voltage AC 100~240V 

Blower power port  
100~220V/2A 

※ Auxiliary Power Device must be used if the external blowers or dust collectors have 

more than 2 Ampere. 

Temperature 15 – 35 C 

Humidity 10 - 90 % 

Purposes 
Metal marking, Ring inner diameter marking, Ring outer diameter 

marking, etc. 
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3. Descriptions 

(1) Machine 
 

 
 

 

 
 

                  
  

D. Laser-shielding 

Display 

C. Safety Door 

G. Control Panel 

J. Vacuum Inlet 

M. USB Port 

L. AC Power Inlet 

B. Power Switch 

I. External device  

fine adjustment knob 

A. Status Indicator 

H. Emergency 

Switch 

E. Scan Head 

K. Outlet for 

Vacuum 

F. Docking Station 

N. IO Port 
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A Status Indicator 
The device status can be checked through the blinking 

interval of the status indicator. 

B Power Switch Turn on/off the power switch. 

C Safety Door 
Press [Safety Door] to open/close the cover automatically.  

※ Once the program is connected, the cover is automatically opened. 

D Laser-shielding Display 
Protects the eyes from laser radiation during laser marking. 

※Wavelength to protect: 1064nm/ Optical density: OD6 

E Scan Head 

A laser irradiation part. 
 

Do not stare at the specular/diffuse reflection of laser. 

It may result in blindness. 

F Docking Station Connects the rotary clamp with the machine. 

G Control Panel Controls the power button and marking machine. 

H Emergency Switch Emergency stop switch. 

I 
External device  

fine adjustment knob 

Left and right fine movement of the rotary clamp position by 

using chuck handle. 

J Vacuum Inlet 
Connects the duct hose to the outlet and removes dust 

generated during machine processing. 

K Outlet for Vacuum 

Connects the blower power. <110~220V/2A> 

※ Auxiliary Power Device must be used if the external 

blowers or dust collectors have more than 2 Ampere. 

L AC Power Inlet 

Connects the power adapter and supplies power to the 

marking machine. 

※ Use the power cable connected to the grounded outlet. 

Unless the outlet is grounded, separately ground the 

machine. 

M USB Port Connects the USB cable plugged into the cable. 

N IO Port 

Signal in/output terminal for external device connection 

※ The external IO port input to the machine must be 5V, 

50mA or less. 

 

  



19 

(2) Keypad 
 

 

Display Status display 

Operation Buttons 
Depending on the situation, it performs the function indicated on the 

display. 

 

 

Direction 

Key (X,Y) 

·Moves marking area. 

·Rotary:  (X) Moves tilting angle 

     (Y)Moves A axis 

 

Direction 

Key (Z) 
Moves Z-axis up and down 

 

Vacuum 

ON/OFF 

Vacuum dust collector power button. 
 

· Automatic control: Starts automatically when engraving and stops 

automatically after engraving is completed. Auto off delay function: 

Dust collection until the remaining dust after engraving is completed. 

(software setting) 
 

· Manual operation: When the user manually turns on the dust 

collector, automatic control is deactivated. When the engraving is 

finished, the user must stop it. 

 
Auto Focus 

· AUTO FOCUS: If the button is pressed shortly (immediately released), 

move and the laser focus to the material height automatically.  

*Auto focus is activated when the program is connected. 

*Only for flat marking 

*Auto focus maximum measurement Height: 55mm 

*Materials that do not reflect the laser pointer precisely, such as 

acrylic, glass, red anodized aluminum, or chrome-plated pendants, 

cannot use auto focus or have poor accuracy. 
 

· MENU: If the button is pressed for a long time (2 second or longer), 

enter the menu mode.  

1: Product Info 

2: Status LED Brightness 

3: Reset Memory 

Press and hold  button until it beeps (more than 2 seconds) to 

run the menu. 

Display 

Operation  

Buttons 
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Start 

Starts marking when pressed for a long time (2 seconds or longer). 

· Repeat marking: Press and hold the  button to finish marking, 

then double-click the  button to mark repeatedly when marking 

the same work.  

 
Stop Stops marking 
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(3) Display 

In the built-in display, you can check the status of each function, messages, and selected functions. Icons are 

displayed differently depending on the functions. The functions performed by the 4 buttons at the bottom of 

the display change depending on the situations. 
 

[Flat-Standby mode] 
 

  

             
 

Status 

Display 

 
LED Light Brightness levels 

 
Focus Pointer Brightness levels 

 
Dust Collector ON/OFF status (Not displayed when OFF) 

 
Z-axis Position Z-axis Position: Material height 

 

Functions 

 
Height 

·If the button is pressed shortly (immediately released): 

Press the button and move the laser focus to the preset 

height. 

 →  →  

·If the button is pressed for a long time (released in 2 

second or later): Once the button is pressed for a long time 

(2 second or longer) after adjusting the laser focus moving 

height, the preset values are saved. 

 
LED Light 

Brightness levels  

·4 levels of brightness control, Each time the button is pressed, 

the level changes and the level cycles. 

 

 
OFF →  LV.1  → LV.2 → LV.3 → LV4 

 

 
Focus Pointer 

Brightness levels  

·4 levels of brightness control, Each time the button is pressed, 

the level changes and the level cycles. 
 

 

 
OFF →  LV.1  → LV.2 → LV.3 → LV4 

 

 
Cover Opens/closes the front cover. 

Status Display 

Functions 

Buttons 
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[Marking Mode] 

 

 

          
 

Status 

Display  

Stop after current 

operation 

It does not stop marking immediately, but after completing 

the marking in progress. 

 

Laser 

Options 

 
Power Displays set laser power value 

 
Speed Displays set laser speed value 

 
Frequency Displays set laser frequency value 

 
Pulse width Displays set laser pulse width value 

 

Time left 
The remaining time until marking completion is displayed. 

*Calculate the time required for the 1st cycle. 

Repeat Count 

When setting a repeat count, the number of repeats is 

displayed. (Example: 2/10 → performing 2 times out of a 

total 10 markings) 

Functions 

 
Pause 

Pause the operation in progress  

 

          

          

 

Stop after current 

operation 

End repeated marking in progress. 

It does not stop marking immediately but stops after 

completing the marking currently being performed. 

 

  

Restart:  

Closes  

when the cover is 

 opened and restarts 

Cover 

Cover open 

after pause 

Functions 

Laser Options 

Buttons 

Repeat Count 
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[Rotary clamp] 

 

 

          

 

[Rotary clamp marking area checking] 

 

          
 

 

Status 

Display 

 
Rotary Clamp Displays the mounting of the rotary clamp 

 
Angle Displays tilting angle 

 

Functions 

 
Rotary Clamp Rotary clamp release button 

 
X-axis/Tilting 

*When checking the rotary clamp marking area 

·Moves when tilting axis is active. 

·When the X-axis is activated, the position moves in the X-

axis direction. 

 

  

Status Display 

Functions 

Buttons 

Functions 

Buttons 
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(4) Status indicator 

There is a built-in status indicator on the left and right bottom of the BB-L3 to indicate the device status, so 

you can easily check the device status. 

 

 
 

 

The status is displayed at the blinking speed of the status indicator, and the status expressed through the 

indicator is as follows. 
 

Status Blinking Interval 

Computer connecting  

Waiting  

Operating  

Notification  

Error  

 

If the button is pressed for a long time (2 second or longer), enter the menu mode. 

· MENU:  

1: Product Info 

2: Status LED Brightness 

3: Reset Memory 
 

Press and hold  button until it beeps (more than 2 seconds) to run the menu. 

Status LED brightness can adjust by using the (Direction X) buttons. 
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4. Installation 
※ Please follow the instruction below in order to use the solution.  

※ This program requires Windows OS 7 or higher.  

 

(1) Installation of marking machine 
 

BB-L3 is a desktop laser marking system. Marking cannot be done with only the machine. 

It should be connected to the personal computer, and the program provided should be used together for 

marking.  

 
     

 
 

 

 

 
 

 

 

Plug the USB cable into the port on the back of the machine and computer’s USB port.  

Plug the power cable into the outlet.  

  

USB Cable 

USB Cable  Computer 

Power Cable  Outlet 
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And switch on the machine. 

 

[Power switch]  

 

             
 

 

[Emergency Switch] 

 

※If the machine is not turned on, check the emergency switch. 

 

          
 

  

Push 

Turn OFF Turn ON 

Turn the button 

Power on Power off 
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(2) Program installation 

Insert the USB into your computer`s USB port, Follow the instructions below to install the software. Install 

program will be automatically run and program installation will proceed in the following order. If the 

program does not run automatically after the USB is connected to your computer, run Install program on My 

Computer’s USB drive. 

1.Setup wizard. 

 

2. Select installation folder. 

 

3. The file is copied onto the hard disk. 

 

4. USB driver setup wizard. 

 

5. Check [I accept the agreement], then click [Next]. 

 

6. After check the [Status: Ready to use], Click 

“Finish” button to complete. 

 

7. Click “Finish” button to complete program 

installation. 
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- Program Description 

Once the installation is completed, the following icon appears on the desktop. The description of the icon is 

as follows: 
 

 

-Program serial number 

 

After installation, the machine serial number is recognized and the correction value stored in the server is 

automatically called and set. 

 

-Press the [OK] button to restart the program automatically after the setting is completed. 

-Press the [Skip] button to skip this process and the setting value is not set automatically. 

 

 

 

- Program password 

 

Only administrators can use the program by using the program password.  

Please make sure to change the default password. 

The program default password is [0000].  

 

 
  

 

As a design & marking software program, it features the following functions: 

marking design, marking option, Toolpath setting, transfer of Toolpath data. 

 

As a machine setting program, It features the following functions: 

Laser focus, Guide laser, Rotary origin, Manual calibration. 
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(3) Driver installation 
 

※ If driver installation is not installed automatically, it is a manual installation method. 

※ Please turn on the machine, and connect the machine with USB cable.  
 

1. Go to [Device Manager], and select the [USBLMCV2] using by the mouse right button. Then select 

[Update driver].  

          
 

2. Follow the instructions below. 
 

① Select [Browse my computer for driver software]. 

 

② Click the [Browse] button. 

 

③ Select the [Driver] folder from the installation CD 

file. 

 

④ Add the [Driver], then click the [Next] button 

. 

 

[Mouse right button click] 
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5. Click “Close” button to complete program 

installation.  

 

 

 

(4) Installation of the blower 

※Blower set is purchased separately.  

※Please be careful of the cut surface of the hose clamp as it may cause injury. 

 

Order to connect the blower.  

 

 
 

 

  

Out take In take 
Machine 

Outlet 

After connect the hose clamp,  

screw the bolt by the wrench. 
Connect the hose to the outlet. 
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(5) Auxiliary power device setup (for external devices) 

※Auxiliary power device set is purchased separately.  

 

Auxiliary power device is required when using the dust collector. 

 

This device must be used if the external blowers or dust collectors have more than 2 Ampere.  

Otherwise, this may result in a machine failure. 

 

 
 

Connect the auxiliary power device to the laser machine. (Refer to the picture below)  
 

                              
 

 

 

 
 

 

Connect to the outlet 

Connect to the laser machine Connect to the dust collector 
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(6) IO Port in/output  
 

※ The external IO port input to the machine must be 5V, 50mA or less. 
 

BB-L3 has a function that outputs machine operational status through the IO port on the rear side and 

receives external signals through the IO port to control operation.  
 

    
 

In order to operate an external device by linking to BB-L3 status signal output, connect the signal line linked 

to the OUT port outputting the status to the external device. To activate BB-L3 by external-device status 

signal, connect the external-device signal line to the IN port linked to BB-L3 operation. Each IO port function 

is as in the following table and plan;  

 
 

 

Power 
+5V Power: +5V power necessary to connect external 

devices 

Output 
Laser Start: Auto laser engraving start upon +5V (High) 

signal output from an external device 

Output 
Laser Stop: Immediate laser engraving stop upon +5V 

(High) signal output from an external device 

Input 
Laser ON Signal: +5V (High) signal is input to an external 

device upon laser engraving start. 

Input 
Laser OFF Signal: +5V (High) signal is input to an external 

device upon laser engraving end. 

Input 

Blower On/Off Signal: When the dust collector is ON, 

+5V (High) is input to an external device; and, if OFF, 

GND (Low). 

Power 
GND: GND power necessary for external-device 

connection 

**Input: Signal received by an external device 

**Output: Signal received by the equipment 
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5. Operation of the marking machine 
 

Turn on the machine. Then, the system performs self-diagnose as follows. Unless a problem is found, it goes 

into a standby mode with confirmation sound.  
 

(1) Self-diagnose procedures when the system is turned on 

1. In case there is a detected axis, move it out of the sensing zone.  

2. Check the cover sensor. 

3. Check the z-axis sensor and return to the origin point. 

4. Return to the origin point. 

5. Confirmation sound and standby 

 

(2) Marking procedures 
 

1) Turn on the marking machine. 

    ※ If the machine does not turn on, check the emergency switch. 
 

2) Start the program and connect it to the machine.  

 
 

3) Put the material on the work area.   

 

4) Set the laser focus, using the direction key (Z) buttons.  

(✽When using auto focus, Also set the laser focus.) 
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5) Prepare the design to mark, and then create the toolpath. 

 
 

6) Set the laser marking option. 

 
 

 

7) Then click the [LASER] button and send the marking data. 

        
 

8) Click [Start] or press  for a long time (2 seconds or longer) to start marking. 
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6. External device 

✽Blower power port : 110~220V/2A 

✽Auxiliary Power Device must be used if the external blowers or dust collectors have more than  

2 Ampere. 
 

1. Connect the power to the back of the machine.  

 
 

2. Click [OTHERS] in [Setup Machine]. 

             
 

 
 

Auto 

In case the [Auto] checkbox is clicked, the external device is automatically 

on/off during BB-L3 operation. 

If the [Auto] checkbox is not selected, the automatic control of external 

devices is disabled. 

Power Off Delay 
The external device power is automatically turned OFF after being delayed 

for the preset time in [Power Off Delay] before power off. 
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7. Clamp 
A guideline can be checked at the work area.  

The work area of the product is 110x110(mm). 

 

 
 

Put the material in the middle of the work area.  

The guideline of the work area is same as the work area of MagicArt. 
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(1) Clamp 

It is able to fix clamp bolts into work area holes.  

Put the clamp at a desired location and screw the clamp bolt.  

 

Clamp 

Set 

Clamp 

 

1SET 

Clamp Bolt 

(M5-12mm)  4EA 
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(2) Medal clamp 

※Medal clamp is purchased separately. 

 

 
Since the holding part of the clamp is step type, set the clamp to the step to match the size and thickness of 

the material. If you move the clamp moving bar upwards; and then turn the fixing knob to the right, the 

clamp will be tightened. 

 

               
 

 

When holding the materials by turning the clamp fixing knob, a mark may be left on the materials. 

 

 

1. Fix the product work area by matching the pins to the holes. 

 
 

  

Fixing knob 

Clamp Fixing part 

Pin holes 

Fixing knob 
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2. Connect the clamp pins to the clamp fixing unit. 

             
 

3. Fix the pin on the clamp.  

Pin holes on the clamp ensures easier holding of irregular shaped material. 

 
 

4. Fix it by turning the fixing knob. 
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(3) Medal clamp-center fixing type 

※Medal clamp is purchased separately. 

 

 
Since the holding part of clamp is step type, set the clamp to the step to match the size and thickness of the 

material. Place the material and turn the clamp handle to the right, and then the clamp will be tightened. 

 

               
 

When holding the materials by turning the clamp handle, a mark may be left on the materials. 

 

 

1. Fix the product work area by matching the pins to the holes. 

 
 

2. Connect the clamp pins to the clamp fixing unit. 

             

Pin holes 

Clamp handle 

Clamp fixing part 
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3. Fix the pin on the clamp.  

Pin holes on the clamp ensures easier holding of irregular shaped material. 

           
 

4. Fix it by turning the clamp handle. 
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(4) L Type clamp 

※L type clamp is purchased separately. 

 

       
  

Put the material tightly on the fixing bracket.  

 

 

- Origin Point Setting 

 

Set the L type clamp position to position the focus at the center of the L type clamp groove. The end position 

is the origin point of L type clamp. Once the origin point is set, it is easy to return L type clamp to its original 

position even after removal. If an X-axis flat clamp is removed, the origin point should be reset.  

 

1. Fix the clamp to set the focus. Set the position of L type clamp and then fix the X-axis (vertical fixation) 

clamp. 

 
 

  

Knob 
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2. Put it tightly on the work area with the clamp as a guide. Then, fix the position of L type clamp.  

 
 

3. Set the focus, using the direction key (Z)  buttons.  

          
 

4. Adjust the position of L type clamp to position the origin point of the focus in the middle of the L type 

clamp groove. 

       
 

5. Fix the X-axis (vertical fixation) clamp. 

  



44 

-Material Focus Setting 

1. Put the material on the fixing bracket.   

 
 

2. Set the focus, using the direction key (Z) buttons. 
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(5) Honeycomb table 

※Honeycomb table is purchased separately. 

 

1. Put the honeycomb table on the honeycomb table tray. 

 

 
 

          

2. Set the position of honeycomb table on the machine.  
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(6) Auto tilt rotary clamp 

 

※ Auto tilt rotary clamp is purchased separately. 

     
 

 

※When using the auto tilting rotary clamp, set the tilting origin to the 0 degree. 

(Refer to [Machine setting]-5.Rotary origin) 
 

[Connect]  
 

1. Place the rotary clamp on the docking station and slide it to the left.  

          
 

2. When the push button is pushed to the left until it comes up completely with a mounting sound, the 

device automatically recognizes the clamp and performs the initial operation. 

            
 
 

3. In the built-in display, displays rotary clamp mounting icon. 

 
 

4. Connect the pin for preventing clamp falling. 
 

  Anti-drop pin (6Ø) (18mm) 

Push button 

Rotary clamp release 
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5. Using the external device fine adjustment knob on the right side of the device, it is possible to move left 

and right slightly. 

                 
 

[Disconnect] 

 

1. Press the rotary clamp release button. 

 

               
 

2. The rotary clamp is tilted 90 degrees, and a guide message is displayed on the display. 

        

               
 

 

3. Press the push button to release the fixed rotary clamp and slide it to the right to keep it..  

             
  

Cancel rotary clamp release 

Push button 
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[Holding method for outer diameter engraving] 

Put the ring into the chuck finger and fix it with the chuck handle.  

 

                
 
 

[Holding method for inner diameter engraving] 
Insert the ring by widening the chuck finger of the rotary clamp. Then, fix it with the chuck handle. 
 

                  
 

[Holding method for thin ring inner diameter engraving] 

When marking the thin rings, change to the 2mm chuck finger by using the chuck finger spanner provided 

along with the product to release. 

Insert the ring by widening the chuck finger of rotary clamp. Then, fix it with the chuck handle. 

 

            
 

[Bangle] 

 

                      



49 

(7) Anti-curling clamp  

※ Anti-curling clamp is purchased separately. 

 

For holding a thin plate in place.  

 

 

1. Fix the product work area by matching the pins to the holes. 

 
 

2. Set the position of anti-curling clamp on the machine.  

 
 

3. Turn the fixing knob to widen the gap of the clamp.  

            
 

      
 [Loosen]               [Tighten]   

Clamp Fixing part 

Fixing knob 

Groove Adjustment knob 
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4. Turn the groove adjustment knob to widen the groove of the clamp.  

           
 

5. Fix a material to be engraved, and then turn the groove adjustment knob to narrow the groove of the 

clamp.  
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Program Usage Description 
Run the program, then a window will appear as shown below. The program window is different in 

accordance with modes. The names of parts for each case are as follows. 

 

◈ Program screen 

 
 

◈ Text input mode 
 

 Press   [Text Input] button and click the screen or double click on the selection mode to switch to 

text input mode. 

  
  

Work area 

Template 

list 

Menu 
Toolbar 

Template category 

Screen zoom in/out tools 

Text property 

Data 

output 

Cursor (text input mode) 
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◈ Object selection mode 

After entering the text, click  [Selection] button with a mouse or right-click the work area. Then, the 

entered text object is selected and it switches over to selection mode. Double click the selection mode to 

switch it to text input mode. 

  

 

◈ Object rotation mode 

If the selected object is clicked once more, the mode will switch over to object rotation mode. 

 

  
  

Object property 

Object selection mode 

Rotation registration information 

Object rotation mode 
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1. Toolbar 
 

◈ Alignment tools 

 
 

 
 

 [Line/Curve]  

 

Click a certain point and drag it to make a dot line appear. Designate 

the distance and click with the mouse and then right-click to create a 

straight line. Then, press “Ctrl” key on the keyboard and move the 

mouse to create a horizontal line or a vertical line.  

 

Click on a certain point and designate a distance. Drag while clicking 

and holding the mouse to make a curve appear. Right-click to create a 

curve. 

 

 [Circle/Oval/Pie] 

 

Click and hold the work area with the mouse and drag it to designate 

the size of a circle. Then, press “Shift” key and drag it to create a perfect 

circle.  

 

Click  button on the circle object property window to convert into 

an arc. The starting/ending angle can be designated and those angles 

can be adjusted by dragging the starting/ending point of the arc with 

the mouse. Then, click  button to create a reversed 

image.   

 

Click  button on the circle object property window to convert into 

a pie (a filled arc). The starting/ending angle can be designated and 

those angles can be adjusted by dragging the starting/ending point of 

the pie with the mouse. Then, click  button to create 

a reversed image.   
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 [Rectangle] 

 

Click and hold the work area with the mouse and drag it to designate 

the size of a rectangle. At this time, press “Shift” key and drag it to create 

a square. 

 

Determine the curvature of each edge on the rectangle object property 

window or drag the rectangular edge with the mouse to convert it into a 

rectangle with round corners. 

 

Click  button on the rectangle object property 

window and adjust the curvature of each corner individually.  

 

 [Polygon] 

 

Click and hold the work area with the mouse and drag it to designate 

the size of a polygon. 

At this time, specify the number of vertex on the polygon object 

property window to change it.  

 

 [Mirror] 

       
Reverse the left/right of the selected object. 

 

 [Rotation] 

           

If the selected object is clicked once more with the 

mouse, it will switch over to the object rotation mode. 

Then, rotate the object by dragging it with the mouse 

or arrow keys on the keyboard. 

 

 [Invert color] 

         

Invers the color of the selected object. 

 

 [90˚CW] 

          

Rotate the selected object by 90˚.  
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 [Vertical center in page] 

          

 [Horizontal center in page] 

          

 [Center in page] 
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[Alignment option] 

 
 

 

 

 

Alignment 

 
Align to the left of base object 

 
Align to the center of base object 

 
Align to the right of base object 

 
Align to the top of base object 

 
Align to the center of base object 

 
Align to the bottom of base object 

Adjust horizontal gap 
 

Align horizontal gap between objects uniformly 

Adjust vertical gap 
 

Align vertical gap between objects uniformly 

Same size 

 
Make same width 

 
Make same height 

 
Make same size 

Alignment  
Vertical center in page 

 
Horizontal center in page 

Order 
 

Bring to front 

 
Send to back 
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◈ Object tools 

 

 
 

      
 

 [Barcode] 

Create the barcode object. 
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 [Design sample] 

Import design sample or save current object as design sample. 

 
 

What is a design sample? 

It means design objects saved in the design sample library. The design sample is easily and quickly 

imported from the design sample library and freely edited. 
 

 [Selection] 

You can select the object created in the work area to adjust its size and location or to change the object’s 

property. Only the selected objects are subject to change their options such as location, size, etc. In the text 

input mode, switch over to selection mode easily by right-clicking the work area. 

        
[Object selected]                  [No object selected] 

 

 [Text input] 

If  button is pressed and the work area is clicked with the mouse, characters can be entered. Double 

clicking in the selection mode is an easier way to switch over to the text input mode. 
 

               
Cursor (Text input mode) 

 

Press  button and drag a character to edit with the mouse for partial selection. Then, adjust its font 

and size. 

 
 [Mouse drag] 
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 [Circular text] 

Create text objects along a circle. 

 
 

 

 [Drawing pen] 

Drawing can be performed by dragging the mouse.  

The thickness of the drawing line can be adjusted in the drawing object property window. 

 
 

 [Outline stroke of object] 

You can insert an outline in the selected object. 
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 [Invert color of overlapped area] 
 

When two or more objects are overlapped, the color in overlapped area can be inverted.  

Move the target object over the first object after clicking button, then overlapped area’s color will be 

inverted. 

                

When inverting text, drag the target object over the text after clicking  button.  

 

 
 

 

 
• [Automatically invert color in overlapped area] function is only applied to straight lines, curved 

lines, circle, rectangle, polygon, design sample and uploaded SVG file, not texts and images. 

• [Automatically invert color in overlapped area] function inverts the color of underlaid object. 

If the color is not inverted, select [Layout menu → Order → Top Most] and place the underlaid 

object above the other object. 
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 [Image] 

Import image (bmp, jpeg, gif, png … etc.). 
 

 
 

 

 [Line eraser] 

Erase the line of a created object.  

Move the mouse over the line of an object, then click the line. The line will be erased (Some objects cannot 

be erased with the Line eraser tool). 
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◈ Toolpath 

Please refer to [4. How to engrave for each toolpath] for details. 

 

 
 

Toolpath? 

Toolpath is a pathway where tool passes by for marking.  

Toolpath is usually displayed in red color and marking tool moves along the pathway as it 

engraves.  
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◈ Origin point setting tools 

 
 

 [Left top origin point]  [Left bottom origin point] 

 
 

 [Center origin point] 
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◈ Basic tools 

 
 

 
 

 [New document] 

Open a new page.  

 
 

 [Open] 

Open a file in “*.dgn” file format. 

Select a file on the “Open” window and click “Open” button. 

 

 [Save document] 

Save the design drawn on program as “*.dgn” file format. 

Choose the location (folder) in which the file will be saved and enter the file name before clicking “Save” 

button. 
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 [Print] 

Print the design drawn on program. 

 

 [Cut]  

Cut the selected object.  If Ctrl+X is pressed on the keyboard, the same function will be executed.  
 

           
Ctrl + X                 Ctrl + V 

 

 [Copy] 

Copy the selected object. If Ctrl+C is pressed on the keyboard, the same function will be executed. 
 

           
Ctrl + C                  Ctrl + V 

 

[Duplicate Horizontally or Vertically…] 

If more than one of the same objects is needed, multi-copy the object at regular intervals by clicking [Edit → 

Copy → Duplicate Horizontally or Vertically…] or pressing  icon in toolbar.  
 

    
 

            
 

 [Paste] 
 

Paste the cut or copied object. 

If [Ctrl+V] is pressed on the keyboard, the same function will be executed. 
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 [Undo / Redo] 

-Undo: Restore the work recently done to its previous state.  

The number of undo steps can be adjusted with [Menu] → [Tool] → [Option] → [General].  

 

                  
 

-Redo: Re-execute the undone work.  

                  
 

                                                                          

  

Change font Undo 

 

Change font Undo 
Redo 
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◈ Screen zoom in/out/move tools 

 

 

 

 

 [Zoom in] 

The screen is zoomed in by one level. 

             
 

 [Zoom out] 

The screen is zoomed out by one level. 
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 [Zoom in/out ratio] 

If desired screen ratio is selected, the screen in the size of the selected ratio will be shown. 

 
 

 [Magnifier] 

Drag a certain spot with the mouse to enlarge it.  

                 
 

 [Fit to object] 

Enlarge the selected object to make it fill in the screen. 

                
 

 [Fit to page] 

Adjust the page size to see the whole work area.  
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 [Panning] 

Drag the screen with the mouse to move it. 

              

 

2. Text object property 
If any text object is selected, the property of the text object will appear on the left of the screen.  

 
 

 [Font] 

 

Designate font. Either click the font’s arrow or click “Preview” button to designate font. 

 

 

 
 

 

 
 

*If you right click the font preview window, a menu appears. Click 

“Show Font List”, then you can designate the fonts that will be used 

in preview.  

  

[Mouse right button click] 
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 [Size] 

Adjust the size of the selected text. Either press the arrow button of [Size] select the size of the font or press 

 [size] button to adjust the size by one level.  

                 
 

 [Bold] 

Change text style to bold.  

               
 

 [Italic] 

Change the text style to italic. 

               
 

 [Reduce or increase font weight by one level] 

Adjust the weight of font. 

                     
 

 [Symbol] 

Insert symbols. 
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   [Text change] 

The entered text of the selected object can be displayed and changed. Edit the text on the text field or press 

 button to change the text more easily when several text objects are selected.  

          
 

 
 

 

 [Text Alignment] 

 

 [Align to left] 

Align characters to the left in the text box. 

 

 [Align to center] 

Align characters to the horizontal center in the text box. 

 

 [Align to right] 

Align characters to the right in the text box. 
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 [Both] 

Align characters to the both direction evenly in the text box. 

 

 [Align to top] 

Align characters to the top in the text box. 

 

 [Align to center] 

Align characters to the vertical center in the text box. 

 

 [Align to bottom] 

Align characters to the bottom in the text box. 

 

 [Horizontal text ] 

Arrange characters horizontally. 

 

 [Vertical text] 

Arrange characters vertically. 

 

 

Move the selected character horizontally (left, right). 

 

 

Move the selected character vertically (up, down). 
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Adjust the width of the selected character. 
 

 

 

Rotate the selected character. 
 

 
 

 [Position/Size] 

 

 [Line and Fill Shape] 

 

Designates the location of the selected object 

 

Designates the size of the selected object 

 

When “Keep Ratio” is checked, width and height of the selected 

object is maintained at the same ratio. 

When “Keep Ratio” is un-checked, width and height of the selected 

object can be adjusted separately.  

 Line thickness of the selected object 

 
Line type of the selected object 

 Line color of the selected object 
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3. Rotation tool property 
If the selected object is clicked once more, the mode will switch over to object rotation mode. 

 
 

 [Rotation] 

 

  

 
Color filled inside of the selected object 

 Shape filled inside of the selected object 

 

Rotate the selected object by designated angle. Enter the desired 

angle of rotation, and then press arrow button.  The object is 

rotated by the angle entered. 

 
Rotate the selected object at the same angle as entered. 

 
Rotate and add a new object at the same angle as entered 
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4. How to engrave for each toolpath 

 
 

Toolpath? 

Toolpath is a pathway where tool passes by for marking. 

Toolpath is usually displayed in red color and marking tool moves along the pathway as it 

engraves.  

 

[Scan-line toolpath]  

Creates toolpath that will engrave inside area of the target object’s boundary. 

“Scan line toolpath” might be similar to “Hatching toolpath”, but it is rather used for logos, patterns or 

objects with larger area.  

          

           
 

 [Outline toolpath] 

Creates a toolpath that will engrave the outline of the selected object. 
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 [Single line toolpath] 

Creates a toolpath that will engrave the center line of the selected object. 

 
 

“Single line toolpath” process may cause the deviation of the center line. 

Thus, it is recommended to use thinner lined font to reduce the deviation.  

 

 [Cut-out toolpath] 

Creates a toolpath that will cut out the selected object.  

The toolpath boundary will be wider than the boundary of the selected object depending on the thickness of 

the tool.  

         
 

 [Photo impact engraving toolpath] 

Creates a toolpath that will engrave an image with dots. 

 

            
 

 [Simulate toolpath processing] 

The predicted image of the toolpath result processed by the selected tool is shown. 

The following is an example. 
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 [Show toolpath only] 

Only toolpath is shown on the screen with temporarily hiding all of the other objects. If this button is pressed 

once again, all objects will be seen again.   

 
 

 [Boundary-line toolpath] 

Creates a toolpath that will engrave the boundary of the selected object. 

           
 

 [Inline toolpath] 

Creates toolpath that will engrave inline of the selected object. 

         
 

The toolpath is created on inner line that is placed within the boundary of the selected object. 

 

 
 

 [Contour line toolpath] 

Creates a toolpath that will engrave the selected object with contour lines. 

         
 

Inline 

Outline 
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 [V-cut toolpath] 

Creates toolpath that will engrave V-cut groove. 
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5. Create toolpath 
 

 
 

(1) Toolpath setting 

[Laser Beam Info: Add/Delete/Edit] 

Select the laser beam. Each engraving option value can be changed by pressing Edit or Add button. 

If “Edit” button is checked, Add/Delete/Edit buttons will appear. 

                 
 

 Designate the name of info to be added along with its type and other options like tip width, then 

click “OK” button. The new info will be added to the selection list. 

 

 Select info from the list and click “Delete” button to delete the selected tool from the list. 
 

 Select info for modifying and click “Edit” button. If “OK” button is clicked after option is modified, 

the modified value will be saved.  
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[Preset: Add/Delete/Edit] 

Hatching angle, gap and others are pre-set for each engraving option. Therefore, it is not necessary to 

designate hatching gap, angle and others every time and they will be automatically set with their pre-set 

values. Each engraving option value can be changed by pressing Edit or Add button. 

 

If “Edit” button is checked, Add/Delete/Edit buttons will appear.  

 

 
 

 

 Enter a name to the preset option setting window and designate hatching gap, angle and etc before 

clicking “OK” button. The option will be added to the preset option selection list. 

 
 

 Select an option to be deleted and click “Delete” button to delete the option from the list.  

 

 Select an option to be modified and click “Edit” button. If “OK” button is clicked after option is 

modified, the modified setting value will be saved.  

 

 

[Option: Add/Delete/Edit] 

Hatching Gap 

Designate hatching gap. 

 
0.1mm       0.2mm      0.3mm 
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Margin 

Designate a margin between object outline and toolpath. 

 
0.1mm       0.2mm       0.3mm 

Hatching angle 

The followings are shown only on hatching Toolpath. 
 

 

A Toolpath is created in the vertical direction 

 

A Toolpath is created in the left diagonal direction 

 

A Toolpath is created in the right diagonal direction 

 

A Toolpath is created in the horizontal direction  

 

A Toolpath is created in the cross hatched direction 

※ This toolpath is not recommended due to possible 

damage to materials with plated surface. 

Engrave outline 

If this option is un-checked, a toolpath for only the inside of the selected 

object is created.  

 

Letter-by-letter  

engraving at first 

object position 

After marking only the specified letter, it waits and marks the entire letters 

by repeating the sequence in which the user manually adjusts the engraving 

position. 

 

(Example: When marking ABC, if the number of characters you would mark 

is one letter) After marking A, the user adjusts the engraving position → 

marking B → engraving position adjustment → marking C 

    
 

Toolpath quality 
Select the toolpath quality.  

The higher quality, the longer toolpath creation time. 

 

[Transmit] 

Toolpath output window is displayed. 
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(2) Convert object to toolpath 

[Convert object to toolpath] is convert selected object to toolpath. It’s not necessary to designate 

toolpath setting every time and they will be automatically set with their pre-set values. Each toolpath option 

value can be changed by pressing Edit or Add button. 

 

 

[Laser Beam Info: Add/Delete/Edit] 

If “Edit” button is checked, Add/Delete/Edit buttons will appear. 

            
 

 Designate the name of info to be added along with its type and other options like tip width, then 

click “OK” button. The new info will be added to the selection list. 
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 Select info from the list and click “Delete” button to delete the selected tool from the list. 

 

 Select info for modifying and click “Edit” button. If “OK” button is clicked after option is modified, the 

modified value will be saved.  

 

[Preset: Add/Delete/Edit] 
 

Toolpath setting pre-set for each toolpath. Therefore, it is not necessary to designate hatching gap, angle 

and others every time and they will be automatically set with their pre-set values. Each toolpath setting value 

can be changed by pressing Edit or Add button. 

 

If “Edit” button is checked, Add/Delete/Edit buttons will appear.  

  

 

 Enter a name to the preset option setting window and designate hatching gap, angle and etc before 

clicking “OK” button. The option will be added to the preset option selection list. 

 
 

 Select an option to be deleted and click “Delete” button to delete the option from the list.  

 

 Select an option to be modified and click “Edit” button. If “OK” button is clicked after option is 

modified, the modified setting value will be saved.  
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6. Laser option 

 

(1) Quick setting 

After creating the toolpath, the laser options settings are displayed on the left side of the program. 

You can set the laser options and immediately mark the selected design. 
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Marking Option Preset Selects the marking option ※ See the details below. 

Power Adjusts the laser output 

Frequency Adjusts the laser frequency 

Speed Adjusts the marking speed 

Repeat Adjusts the marking repetition 

Repeat Marking with Focus 

Moved Down after Finish 

Adjusts marking depth upon selection of Deep Marking. 
 

ex) 0.05mm per marking, 2 times 

- Focus Auto Down Depth per Pass:0.05mm 

- Total Focus Down: 0.1mm 

Multi steps Material Height 

From Origin 

Batch engraving on materials with multilevel heights. 

Enter the heights from the focus surface to marking surface 

in the program, then the system adjusts focus according to 

the material heights automatically and performs engraving. 

ex) Marking by moving up by 1mm 

 

[Add/ Edit and Save/Delete] 

Laser options such as power and speed can be set in advance.  

Press [Edit and Save] and click the button at the bottom. Then, you can change options.  

 

 
 

(2) Marking option window 

 

After creating the toolpath, click the [Marking Option] button to set the laser option. 
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A laser option window pops up. Adjust the laser option. Then, the marking data are sent to the machine.  

 

 
 

Engraving object Checks the object to engrave 

Preset Selects the marking option ※ See the details below. 

Option 

Changes the laser option ※ See the details below. 

Advanced Option 

Changes the advanced option  

 

Power Adjusts the laser output 

Frequency Adjusts the laser frequency 

Speed Adjusts the speed 

Repeat Count Adjusts the repetition 

Deep 

Marking 

Depth Adjusts marking depth upon selection of Deep Marking  

Z-Movement 

The depth specified upon selection of Deep Marking is not 

marked at once. It is adjusted by Z-axis moving unit.  

E.g.) Deep Marking-specified depth:  

In the event of 1.2mm/0.3mm Z-axis moving unit, a depth 

of 1.2mm is marked (0.3mm per marking, 4 times).  
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Cleaner Perform the marking for cleaning. 

Material Selects the preset marking height ※ See the details below. 

Laser 

Focus 
Material height 

Since the laser focus changes according to the height of 

the material, the height is adjusted accordingly.  

Or set the focus by entering the material height directly. 

 

[Preset] 

Laser options such as marking type, power and speed can be set in advance.  

Press [EDIT] and click the button at the bottom. Then, you can change options.  
 

 
 

-Add 

This menu is used to add a new marking option.   

Set the options (name, engrave type, power, frequency, speed, etc.) and click [Save]. 
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-Edit 

This menu is used to edit marking options.  

Edit the options and click [Save]. 

 

 
 

-Delete 

Deletes marking options  

 

 
 

[Options] 

Marking types can be selected. Laser options change depending on an marking type. Adjust the value and 

click [Save as].  
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[Material] 

The height of laser focus can be set by material.  

Press [Edit] and click the button at the bottom to change options.  

 

 
 

-Add 

This menu is used to add new material setting.  

Set the name and material height and click [Save].  

 

 
 

-Edit 

This menu is for editing material settings.  

Change the option and click [Save]. 

 

 
 

-Delete 

Deletes the material option  
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[Rotary Engraving Option] 

In case of rotary engraving, the diameter and width information which were entered at design by MagicArt 

is applied and shown as it is. Then, laser focus is automatically set, using the value.  

In case of using auto tilt rotary clamp, Auto-calculates focuses height according to the tilted angle in case of 

inner/outer diameter.  

 

 
 

In case of inner diameter, angle is calculated and notified.  
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[Laser Option by Toolpath] 
 

There are differences in laser options by Toolpath.  
 

-Cutting Toolpath 
 

•Overpath: Improves cutting completeness by cutting from the starting point to the preset value with laser. 
 

•Move Focus: Same as the focus depth setting. When cutting the engraving depth little by little, designate 

the depth.  

 

-Image Engraving Toolpath 
 

•Point Number: Since an image is engraved with tiny points, the level of image-engraving completeness can 

be adjusted by setting the number of points engraved at a time. 
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7. Data output 
Select toolpath and click machine button on the top-right of the screen to transfer the selected toolpath to 

the machine. 

 
 

 
 

(1) LASER 

After create the toolpath, and set the laser marking option. And then click the [LASER] button and send the 

marking data.  
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(2) Marking option  

 Click the [Marking Option] button to set the laser option. 

(✽See 6. Laser option for details.) 

  

(3) Marking order 

 
When two or more toolpaths are selected for marking, they will be placed in order.  

The order can be adjusted by [Up], [Down] button on the right. 
 

 
 

(4) Preview 

  
After selecting an object, you can preview the marking area by pressing the button. 

✽This function is available after selecting an object. 

✽You can change the position with the arrow keys in the preview state. (However, this is not possible when 

the auto positioning function is activated.) 
 

The icon will change when you start the preview. 
 

           
 

Rectangle 
The marking area is indicated by a rectangle. However, rotary marking is 

only available for Rectangle preview. 

Outline The marking area is indicated by an object outline. 
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(5) Camera 
 

Activate the camera function. 

BB-L3 has a built-in camera filming laser marking areas. This camera takes the images of materials inside a 

laser marking area and sends the material images to the program along with their size and location data in 

order for users to design directly on the images of real engraving materials and set a marking size and 

location. 
 

✽BB-L3 Filming area: 80mm x 80mm 

 
 

          
 

The laser must be focused in order to use auto positioning properly. 

Since the camera calibration done at the laser focus criterion, if the focus does not fit, the lower the 

accuracy of the auto positioning. 
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Refresh Renew the camera image displayed in the Magic Art Program. 

Camera On 
Activate/Inactivate the camera function. 

When [Camera on], auto positioning is also used. 

AF See 8. Auto Focus for details. 

Image Adjustment 

Set the camera image options such as contrast, grayscale etc. 
 

 

Image Size 

Set the size of the camera image displayed in the program. 

✽It cannot exceed the maximum area of the camera function 

supported by the machine. 
 

 

Auto Image Refresh 

Interval 

You can set the auto image renewal interval displayed in the 

program. 

- Setting range: min. 5 sec. ~ max. 30 sec. 
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Camera Viewer 

View the camera image in a new window. 

 

Camera Selection 

Select your camera device. 

If there are multiple camera devices connected to the PC, by 

default, the camera for laser is set automatically, but you can select 

the device manually. 
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8. Auto focus 
BB-L3 has a built-in auto focusing system that automatically focuses on a surface to mark through a material 

height-sensing camera.  
 

✽Auto focus maximum measurement Height: 55mm 

✽Precision: 0.5mm 
 

            
 

*Auto focus is auxiliary function. When using auto focus, also set the laser focus. 

*Auto focus is unavailable for rotary marking. 

 

Depending upon material characteristics, the auto focusing may become unusable or less precise. 

※Such conditions are summarized as follows;  

-Materials scattering the focus laser rays (Ex: Bakelite, white acryl, etc.) 

-Transparent materials penetrated by the focus laser rays (Ex: Transparent acryl, glass, etc.) 

-Red-color materials, the same color with that of the focus laser rays  

(Ex: Red-color anodizing aluminum, etc.) 

-Mirror-surface materials with high reflexibility such as chromium-plated materials, etc.  

(Ex: Chromium-plated pendants, etc.) 

-Other materials on which the focus pointer is not clearly seen. 

 

1. Click the [AF] button at the top right of the program. 

 

   
 
 

Or press the button on BB-L3. 
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2. When autofocus is started, the program screen displays the progress of the function. 

         
 

 

Also check the progress of the autofocus function on the display screen. 

 

 
 

3. If you want to cancel the autofocus, press the  button on BB-L3. 
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Marking process 
 

 
 

1. Measure the size and height of a material.  

 

2. Place the material on the work area and set the laser focus, using the direction key (Z) buttons.  

(✽When using auto focus, Also set the laser focus.) 

 

          
 

3. Once a template appears, click [  (Enter/edit characters)]. Move the mouse pointer to a wanted 

position and click it. Then, enter the characters.  

 

 
  

Height 

Thickness 
Width 
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4. Once characters are entered, click [  (Select)] on the toolbar and open the Select Object mode. Then, 

select the entered character and edit its size, font and boldness. To put the object in the middle of the work 

area, click [  (alignment in the middle of a work area)].  
 

  
 

5. Once the design is completed, click [  (Scanned line Toolpath)]. A Toolpath refers to a path way of 

tools.  

✽ Click  on the right top without creating a Toolpath for immediate Marking.   
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6. Select an option on the Toolpath page. If necessary, set the hatching interval and click [Create Toolpath]. 

  Then a Toolpath object is being created. 

 

 
 

 

7. After create the toolpath, set the laser marking option. Then click  on the right top. 
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8. Once a red laser pointer on the material is turned on, check and adjust the position of the pointer, using 

the direction keys. The area pointed by the red rectangular laser pointer refers to an actual marking zone. 

The round laser pointer in the middle represents the origin of the height of laser focus.  

 

 

Whenever the direction key is pressed, the laser pointer moves 

up/down/left/right, showing a marking area. Check if the marking zone is 

matched with the area on the material to be actually engraved. If unmatched, 

adjust the position, using the direction keys.  

 

Once the direction key is pressed, the laser pointer moves up/down/left/right 

in the marking zone. In other words, if a laser pointer is situated on the left 

side, press [ ] to move the marking zone to the left.  

 

 
 

9. Once the marking position setting is done, click the program [Start] button or [ ] on the machine for a 

long time (2 seconds or longer). Then, the cover is automatically closed, and marking begins.  

· Repeat marking: Press and hold the  button to finish marking, then double-click the  button to 

mark repeatedly when marking the same work. 
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Marking process of ring Inner/outer diameter 
 

 
 

In case of inner diameter marking outside the limit of 20°, marking may not be possible. 

If outside the indicated angle and the marking position, marking may not be possible. 

 

1. Measure the width and diameter of a ring to be engraved.  

 

                                         
<Outer diameter marking – Ring outside size>             <Inner diameter marking – Ring inside size> 

 

2. Place the material on the clamp and set the laser focus, using the direction key (Z)  buttons. 

-L type clmap 

※L type clamp is purchased separately. 

After loosen the fixing knob, adjust the angle then fasten the fixing knob.  

 <Outer diameter> 

 

                     <Inner diameter> 

 

Width 

Diameter 

Width 

Diameter 



104 

-Roatary Clmap 
 

※Rotary clamp is purchased separately.  

 

In case of using a rotary clamp, the clamp or material sometimes gets in the path of focus pointer ray to 

cover the pointer ray and disturb focusing.  

BB-L3 provides the function to make the guide laser radiating vertically through the scan head available for 

focusing and focus by replacing the points with blocked paths. 

 

Press the focus-pointer brightness control button for at least 1 second to turn on the 3rd focus pointer. 

 

          
 

 

          

  

Buttons 
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3. Double click “Ring” template in the object property window. 

When [Insert Rotary Object Template] window appears, select the outside/inside,  

Then enter the measured width and diameter of the ring and click “OK.” 
 

 
 

4. The template appears at the center of the screen. And select  [Text Input] on the toolbar, and click 

the work area using mouse and enter text to be engraved. 
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5. After entering text, press  [Selection] on the toolbar to enter the object selection mode. Select the 

text, and edit the size and font of the object. To place the object at the center of the work area, click  

[Center in Page] button. 

    
 

Handle for adjusting gaps between characters? 

A function adjusting gaps between characters by dragging characters to target positions.  

 

[Object position]  

     

 

6. Once design is completed, click [ Scanned line Toolpath] button. A Toolpath refers to a path way of 

tools.  
 

 
 

Rotary 

Fixing 

Part  

1
 

2
 

Handle for adjusting 

character gap 

1 

2 
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7. Once “Scanned line toolpath” window appears as shown in the picture below, select tool, toolpath gap 

and depth, and click “Create Toolpath” button. 
 

-Letter-by-letter rotary engraving: Engrave the each text at fixed angle when rotary marking 

 (Text marking only) 

  
 

8. The “Toolpath” object is created as shown below and usually marked with red line on the screen. Scroll the 

mouse wheel to enlarge the toolpath object, and if it is not the desired toolpath, delete the toolpath and 

create it again by adjusting the toolpath option.  

 
※This functions is not supported image marking.  

 

9. After selecting one or more created toolpaths, set the laser marking option. 

Then click  button. 

 

Marking position 
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10. Once a red laser pointer on the material is turned on, check and adjust the position of the pointer, using 

the direction keys. The area pointed by the red rectangular laser pointer refers to an actual marking zone. 

The round laser pointer in the middle represents the origin of the height of laser focus.  

 

 

Whenever the direction key is pressed, the laser pointer moves 

up/down/left/right, showing a marking area. Check if the marking zone is 

matched with the area on the material to be actually engraved. If unmatched, 

adjust the position, using the direction keys.  

 

Once the direction key is pressed, the laser pointer moves up/down/left/right 

in the marking zone. In other words, if a laser pointer is situated on the left 

side, press  to move the marking zone to the left.   

 

 

 

     
 

11. Once the marking position setting is done, click the program [Start button] or [ ] on the machine 

long (2 seconds or longer). Then, the cover is automatically closed, and marking begins.   

· Repeat marking: Press and hold the  button to finish marking, then double-click the  button to 

mark repeatedly when marking the same work. 
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Photo marking 
 

 
What is photo marking? 

This is a marking method to display the shade of image with dots. 

 

1. Place the material on the clamp and set the laser focus, using the direction key (Z)  buttons. 

 
 

2. Click  [Image] to import an image for marking.  
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3. Adjust the size and location of the image. 

 
 

 

 

 
 

4. [Clipping Mask] function enables cutting out target area extracted from the image.  

 Create a shape to designate the target area and drag it on to the image.  

  
 

[Mouse drag] 

[Mouse drag] 
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5. Drag a mouse to select the target area and the whole image. Or select [Menu] → [Edit] → [Select All]. 
 

 
 

6. Select [Menu] → [Transform] → [Make Clipping Mask]. The target image remains except the external 

image. 
 

 
 

 

The whole actual image is already saved in the file, not erased. 

  

[Mouse drag] 
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7. Click  [Photo Impact Engraving Toolpath] button. 

 
 

8. Adjust marking option in photo marking option window. 

 
✽ The black area cut by clipping mask is not being engraved. 

 

When marking a photo, the bright part (white area) of the image is expressed in dots.  Since the 

darker image shows higher quality, adjust the brightness to be darker. Normally, dot ratio 10-20% 

shows the best marking quality for a portrait. The optimal image condition depends on the 

brightness of background of the image.  Adjust the image monitoring the image preview and 

the dot ratio. 

If ‘image adjustment’ is confusing, click “Recommend the best” button to automatically adjust the 

image. 
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9. Click “OK” button to create toolpath for photo marking.  

And set the laser marking option, then click  button. 

 
 

When marking a photo, the white area of the image appears as a dot. So the result of the toolpath 

is shown as a negative image. 

 

10. Once a red laser pointer on the material is turned on, check and adjust the position of the pointer, using 

the direction keys.   

The area pointed by the red rectangular laser pointer refers to an actual marking zone. The round laser 

pointer in the middle represents the origin of the height of laser focus.  

 

 

Whenever the direction key is pressed, the laser pointer moves up/down/ 

left/right, showing a marking area. Check if the marking zone is matched with 

the area on the material to be actually engraved. If unmatched, adjust the 

position, using the direction keys.  

 

Once the direction key is pressed, the laser pointer moves up/down/left/right 

in the marking zone. In other words, if a laser pointer is situated on the left 

side, press [ ] to move the marking zone to the left.  
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11. Once the marking position setting is done, click the program Start button or [ ] on the machine for a 

long time (2 seconds or longer). Then, the cover is automatically closed, and marking begins.   

· Repeat marking: Press and hold the  button to finish marking, then double-click the  button to 

mark repeatedly when marking the same work. 
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Cutting process 
 

※Honeycomb table is purchased separately. 

 

1. Measure the thickness of a material to be cut. 

 
 

2. Place a material to be cut on the honeycomb table and place it on the work area. 

 Then set the laser focus, using the direction key (Z)  buttons.  

 
 

3. Press  [Text Input] on the toolbar to enter the text input mode, and click the work area you want 

and enter the text. 
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4. After entering text, press  [Selection] on the toolbar to select the text and designate the font. 

 

 
 

Adjust the text to the desired size. The size can be adjusted by using an object handle (a square in the 

picture below) as shown below, or from the object property window. 

 

 

 
 

 

 

5. Drag the text gap adjustment handle (a square in the picture below) with the mouse to narrow or widen 

the gap between the characters. 

 
  

Object Handle 

 

[Mouse drag] 

Object Handle 
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If the gap of some characters is partially adjusted, press  [Text Input] button and drag the mouse to 

select the characters you want. Drag a text gap adjustment handle with the mouse and adjust the gap. 

 

       

           [Enter text]                              [Press  button and click with the mouse] 

 

 

 

             
[Select characters]                              [Adjust character gap] 

 

 

6. Insert a type of ring connected to the characters from the design sample section. 

*Design sample: Click  or [Menu] → [View] → [Design sample].  

 
 

7. Select a type of ring and double click it to load in the work area.  
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8. [Copy] and [Paste] the ring type, then guideline for a location of the ring appears.  Adjust the location 

and click the spot.  

 

Copy the target object by pressing [Ctrl+C] 

 
 

 

 

Paste the target object by pressing [Ctrl+V] 

 
 

 

 

Confirm the location and click the spot. 

 
 

9. Select all the objects for the design, right-click on it to see the menu and select [Group].  

 
✽Selecting the whole objects: Drag the object with mouse or select [Menu] → [Edit] → [Select All]. 
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10. Once the design is completed, click  [Cut-Out Toolpath].  

 

 
 

11. Once the “Cut-Out” window appears as seen in the figure below, select tool to be used for the cutting, 

enter the measured material thickness and the other options and click “Create Toolpath.”  
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12. “Toolpath” is created. 

 
 

 
 

13. After create the toolpath, set the laser marking option. Then click  button. 

 

 
  

  



121 

14. Once a laser on the material is turned on, check and adjust the position of the pointer, using the 

direction keys.   

The area pointed by the red rectangular laser pointer refers to an actual marking zone. The round laser 

pointer in the middle represents the origin of the height of laser focus.  

 

 

Whenever the direction key is pressed, the laser pointer moves 

up/down/left/right, showing a marking area. Check if the marking zone is 

matched with the area on the material to be actually engraved. If unmatched, 

adjust the position, using the direction keys.  

 

Once the direction key is pressed, the laser pointer moves up/down/left/right 

in the marking zone. In other words, if a laser pointer is situated on the left 

side, press [ ] to move the marking zone to the left.  

 

 
 

15. Once the marking position setting is done, click the program Start button or [ ] on the machine for 

a long time (2 seconds or longer). Then, the cover is automatically closed, and marking begins.   
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Curved material marking 
 

For marking on curved surface, select a curved template. Enter the height and length of the curved surface. 

Then, z-axis automatically moves along the surface and marks letters one by one.   
 

 
 

In terms of marking on curved surface, texts are only available. 

 
 

1. Select the [Curved] template.  

 
 

With the curvature information, Z-axis shift is calculated. Therefore, if an incorrect size is entered,  

Z-axis error can occur. 

 

 

 

 

 

  

  

Height 

width 
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When entering curvature information, put the material on the floor as shown in the figure. Then, enter the 

distance between the two points which touch the floor.   

 

 

 

 

 

2. Enter texts and create a tool path. Then, Z-axis information appears on the screen as shown in the figure 

below:  

 

 
 

3. Send data and start marking. Then, Z-axis automatically moves and marks according to angles.  

 

 
  

E 

Width 

Depth 
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Shape distortion 
 

 
Due to curvature, text and shape can be distorted during laser marking. If marked under this mode, such 

distortion can be corrected.  

 

- Check the guide laser on your own and enter the distortion value. 

- This function is available for figures and texts only (NOT for pictures and circular texts).   

 

[Figure Shape Distortion] 

Able to distort the shapes of the figures provided by MAGIC ART 

Create figures and click [Menu] → [Transform] → [Distortion]. 
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[Text Shape Distortion] 

 

If [Distort Shape] is clicked without converting an object into a curve, texts are distorted one by one. 

 

 

1. Enter texts and click [Menu] → [Transform] → [Convert to polyline].  

(Or select an object and right-click → [Convert to polyline]) 

 

* Texts change to figures when converted into curves so that they cannot be edited. 
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2. Once texts are converted into curves, change [Fill Shape] to [Infill] in the SHAPE on the left.  

 

 

 

3. Click [Menu] → [Transform] → [Distortion]. 
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4. Enter shape and values. If a negative value is entered, a direction of distortion changes. 

 

5. Enter shape and values. If a negative value is entered, a direction of distortion changes. 
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Layout of text in a circle 
 

Text can be laid out in a circle by using circular text object. 

 

  
 

 [Circular Text]  

Click  button to display “Circular Text” window. Designate direction and angle, enter the size and text, 

then click “OK” button. 
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 [Circular Text- Top/Bottom]  

      

[Adjusting layout angle] 

Drag the first character [R] or last character [y] in the text to adjust the angle of the layout. 

 

          
 

 

 

 

Drag other characters with the mouse to adjust the distance to the center of the circle. 

                          
 

 

Drag with mouse to adjust 

the layout angle. 

Drag with mouse to adjust 

distance from the center of the 

circle. 
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Layout of text on a curve 

1. Click the  [Line/Curve] button. 

 

2. Click on a certain point with the mouse and designate a distance. Drag the mouse to make a curve appear. 

Press the right button on the mouse to create the curve. 

 

  
 

3. Select “No Line” on the “Line and Fill Shape” window on the object property window. 

 

               
 

4. Click  [Text Input] button, and move the mouse cursor to the curve line. The cursor shape will change 

as shown below. 

                 
 

5. In the state in which the cursor shape is chaged, click to enter the text input mode. 

 

  

[Mouse drag] 
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Text change 
The text contents in text objects can be easily changed by the [Text Change] feature. 

Import a saved design sample, file, or select text objects designed on the screen. Click  [Text change] 

button or right- click the mouse, and select [Text Change] on the menu. 

Or select [Menu] → [Text] → [Text change].  

 

 
 

Change contents in the “Text Change” window, and click “OK” button. The changed texts will be shown on 

the screen. 
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Template creation 
 

Template is an image corresponding to the materials to be engraved by 1:1 ratio. Load a template that is the 

most similar to the material to be engraved, and enter the text to be engraved. This allows you to create the 

location of marking and the size of text to be engraved more easily and conveniently. Circle, heart, square 

and diamond-shaped templates are initially provided by the program and users can freely add more 

templates. The shape of a template can be designed by graphic program (Illustrator, Photoshop, CorelDraw 

and etc.) and loaded by SVG file format. Also scanned image file such as jpeg, bmp, png, etc. can be applied 

as template. 

 

[Creating template #1] 

1. Select [Menu] → [Template] → [Create Template from Image]. 

 

 
 

2. "Create Template from Image” window appears.  
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3. Select image files (jpeg, bmp, png and etc.) from the “Open” window, and click “Open” button. 

 
 

4. Input size of the template. Check “Save” to save the loaded image as a template for later use and enter a 

name for the template. Click “OK” button to load the image as a template.  If “Save” is checked, and the 

template name is given, the loaded image will be saved as a template in the template library simultaneously. 
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[Creating template #2] 

1. Press  [Image] button to open an image. 

 

     
 

2. Select [Menu] → [Template] → [Save Selected Object as Template].  

Type a name of the new template in “Input” window.  

 

 
 

 

 

 
 

  



135 

3. The saved template is added in the template library. 
 

 
 

The template saved in the “Save Selected Object as Template” menu is saved as designated size to 

the screen. When loading the template, check “Maintain Original Size”, then the template will be 

loaded with the original size designated when the template was saved. 
 

 
 

✽ Right-click in the template category window for more template related features. The template can be 

deleted by “Delete” on the menu that appears by right-click in template list window. 

  

[Mouse right button click] 
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Saving as design sample 
Edited contents can be saved as design sample for easier access to the design. 

 

[Saving as design sample #1] 

1. Edit contents and select the objects. 

 
 

2. Click File [Menu] → [Save as Design Sample] and select a folder or create new folder.  

Enter the name and click “Save” button to save it. 
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[Saving as design sample #2] 

 

1. Select objects, and click  [Design Sample] button. And select a folder to save the objects from 

design sample library window. 

 
 

2. Click [Save selected image as sample] or right-click the design sample image, and click “Save Selected 

as Design Sample” menu.  

 

 

 
 

[Mouse right button click] 
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3. Enter the name to be saved, and click “OK” button to save it in the design sample library. 

 

 
 

          
 
✽ Right-click in the design sample window for more related features. The design sample can be deleted by  

click  or “Delete” on the menu that appears by right-click in design sample window. 

 

 

  

[Mouse right button click] 
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Auto change of serial number 
 

Use this function when changing numbers by certain unit. 

 

1. Edit the font and size of text object with a number, and press “Alt+N” key on a keyboard, or select [Menu] 

→ [Text] → [Serial Number] → [Advance Serial Number] to change the number automatically. 

 

 
 

 
 

 

            
 

 

2. Select [Menu] → [Text] → [Serial Number] → [Serial Number Option] and enter a unit from the “Serial 

Number Auto Advancing Option” to change the serial number by the designated unit automatically. 
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3. If the serial number is not regular, then select [Menu] → [Text] → [Serial Number] → [Load Serial Number]. 

Enter serial number in the “Lines to export” field or click “Load File” button to load it from a file (.txt or .csv 

file format).  

Once serial numbers are loaded, click “Export to object” button. The text on the selected text object is 

automatically changed, and the serial number is deleted from the list. The deleted numbers will be shown in 

the “Exported Lines”. 
 

 
 

 
Serial numbers can be loaded from a file separated by a comma (.csv) or text file (.txt).  

Each row of the file is recognized as one serial number, and the contents of each row separated 

by comma are shown in the next line. 
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Loading and editing image 
 

1. Loading an image 
This program provides a function to load various types of image files. Supported image file types are as 

follows. 
 

BMP Windows or OS/2’s bitmap graphic file 

GIF CompuServe graphic file 

JPG/JPEG JPEG bitmap graphic file 

PNG Portable Network Graphics bitmap graphic file 

PCX Z Soft PC paintbrush bitmap file 

TIF/TIFF Tagged Image File Format bitmap file 

WMF Windows meta file 
 

Image file can be loaded by following method. 

1. Select  [Image] on the toolbar or select [Menu] → [Insert] → [Image]. 

 
 

2. When “Open” window appears as the figure below, select the image to be loaded, and click “Open” 

button. 
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3. Drag the work area with the mouse to load the image by desired size. 
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2. Converting and editing image 
 

Only single color image can be engraved. Since multiple color images cannot be engraved by machine, it 

should be converted to a single color (1 bit) image. 

 

[Converting to single color image] 

 

1. Select the image object you want to convert, and click “Convert” button in the image object window and 

select “Monochrome (1bit).” 

 
 

Or select the Transform menu → Bitmap → Mode → Monochrome (1bit). 

 
 

2. “Color Image to Black & White” window appears as shown below. Adjust the slider to change it to the 

most suitable single color, and click “OK” button. 
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[Editing image] 

Loaded image can be edited by “Paint” program in Windows.  

Select the image object to be edited, right-click it to select “Edit” or select [Menu] → [Transform] → [Bitmap] 

→ [Edit].  

 
 

Click [OK] to run Windows Paint program. 

 
 

Then, Windows Paint program will show the image.  

After editing the image, press “Save” from the File menu of Paint, and close the program to apply the edit. 
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Import a file in SVG format 
Loading vector graphic files such as SVG file is also supported. 

The SVG file is created by various graphic programs such as Illustrator, CorelDraw etc. 

 

1. Select File menu → Save As from Illustrator program to save a file in SVG type. 

 
 

 

 

 

2. SVG option window appears. Press “OK” button to complete the save.  

 
  



146 

3. Click  button to load the SVG file. 

 
 

4. Or select [Menu] → [File] → [Import…] to import a file. 
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Machine setting 
 

※ The machine is shipped out with default setting. Please contact the customer service center before 

changing the setting.  

※ Set the machine in the following order: Laser focus calibration - Guide laser calibration - Focus pointer –

Correction - Rotary origin calibration (When using it) – Camera. 

※ A machine setting program is separately provided. Start the program first to set the marking machine. 

※ Calibrate a proper material according to the marking machine. The warranty shall not cover any damage 

resulting from the use of an improper material. 

※ Choose a black anodized aluminum material. 

 
 

 
 

1. Use camera view 
When the checkbox is selected, the camera view window appears. 

When calibrating each setting, it helps you to accurately check and calibrate using the camera view. 
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2. Laser focus calibration 
Calibrate the laser focus according to the height of a material and improve marking accuracy.  

It is divided into 4 stages. In each stage, the head moves according to the distance specified in the previous 

stage, and the moving interval shortens.  

 

1. Place a material on the work area.   

 
 

2. Click [Laser Focus] on the Machine Setting.  

 
 

4. After checking the message, click [Next]. Then, the laser focus calibration procedure appears. 

Enter the height of a material.  
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5. Check the warning message and click [Start]. 

 
 

6. The numbers and circles are engraved on the fixed material.  

The numbers range from ‘01’ to ‘10’. However, the numbers actually engraved can differ depending on the 

laser focus.  

  
 

7. Enter the middle number among the engraved numbers on the Engrave Machine Setting page and click 

[OK]. EX) In this example, ‘5’ is positioned in the middle. Therefore, ‘5’ is entered.  
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8. Repeat the processes (Clauses 5-6) 4 times and finish the calibration with the options optimized for laser 

focus.   

 
 

3. Guide laser calibration  
Calibrates the size and position of a guide laser. 

 

1. Place a material on the work area. 

 
 

2. Click [Guide Laser] on the Machine Setting. 
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3. Check the message and click [Next]. 

 
 

4. Set the size and height of a material (a rectangle to be marked) and click [Apply]. 

To mark the rectangle, click [Mark]. Then, the cover is automatically closed, and the rectangle is engraved on 

the material.  

 

     
*A 20mm rectangle is engraved on the 0.5mm-high material.* 

 

  

Marking 

Line 
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5. Once a guide laser appears after the end of marking, adjust the offset values, width and height according 

to the rectangle in ‘2. Parameter Setting’ and click [Apply].  
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※ Select the laser option on the Guide Laser page and adjust laser options.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[Advanced guide laser] 

 

1. Click [Other] in [Setup Machine]. 
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Speed Set the guide laser speed 

Enable Auto Speed 

Adjustment 

Automatically adjusts the guide laser speed according to the size of 

the object to be marked. 

Enable Fine Adjustment 

When checking the engraving area, it automatically moves to the 

guide laser focus position, enabling precise marking area position. 

A menu is added to the setup machine window when the function 

is activated. 

✽Advanced guide laser calibration is required, and the method is 

the same as guide laser calibration. 
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4. Focus pointer 
 

Set the position of the head laser pointer and V laser pointers.  

 

1. Select [Focus Pointer] in the Machine Settings.  

 

 
 

2. Adjust to position head pointer in the center of the cross on the workspace, using the arrow buttons. 

Then, click [Next].  
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3. Place the flat material on the workspace and enter the thickness. Then click [Next]. 

 

  
 

4. Press the ▶ button on the right and proceed sequentially. (A 2,3mm wrench is required.) 

  All steps are 4 steps, and both pointers must proceed in the same way.  
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5. Rotary origin 
 

1. Fix the rotary clamp to the work area. 

 

2. Click [Rotary Origin] on the machine setting. 

 
 

3. First, when using the auto tilting rotary clamp, set the tilting origin to the 0 degree. 

       
 

Adjust the clamp angle in order to the cross mark on the clamp body lines up with the clamp support line. 

Each press of the  button adjusts the angle up/down by 0.1 degree. 

After adjusting the angle to the position of 0 degree, click the [Next] button. 

 

  



158 

4. Fix the tool with a sharp edge to the rotary as described below: 

 

       
 

5. To position the laser pointer at the tip, adjust the machine with the direction keys. Then, click [Next]. Or, 

adjust the position, using the the   buttons and click  long (1 second or longer). 

 

 
 

6. Remove the fixed tool, then Insert the ring into the chuck finger as shown below, and tighten the clamp 

to set it. 
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7. Move to the stage II. And insert the ring size on the program.  

 

  
 

8. Move the [H pointer] to the center of the ring by using arrow buttons. Then, click [Complete]. 
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6. Correction 
When the laser passes the scan head and comes all the way through the lens, the farther it moves away from 

the central point the greater distortion in shapes and sizes is introduced as shown in the figure below. The 

process of calibrating such a distortion, as shown in the figure on right, is known as correction. 

 

 
 

 

1. As the laser marks the area that measures the same or larger than the maximum size (110x110 mm), 

prepare the material that measures at least 120x120 mm in size. 
 

2. Click [Correction] on the Machine Setting. 

 
 

3. The following screen provides the brief explanation on the calibration process. Click the [Next] button to 

start calibration. 
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4. Enter the height of the material and click the [Apply] button. Then, click the [Mark] button to start 

marking 

 
  

5. Enter the sizes and click “Complete” button to finish the calibration process. 

 

 
 

Make sure that the size is measured from each corner as shown in the figures below. 
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7. Camera 
1. Place a material on the work area. (*Please using the black paper for camera setting.) 

 
 

2. Click [Camera] on the Machine Setting. 

 
 

3. Set the height of a material (a rectangle to be marked) and click [Apply]. 

To mark the rectangle, click [Mark]. Then, the cover is automatically closed, and the 80*80mm rectangle is 

engraved on the material.  
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4. Check the camera window, click [Next]. 

 
 

5. Align the four red borders with each corner of the marked rectangle. 

Move it with the mouse to determine the approximate position, and then press the arrow keys on the 

keyboard to make fine adjustment to set the position. Then click [Next]. 
 

               
[Camera screen] 

 

6. Check that the red borders of the camera screen match the marked border. If they do not match, go back 

to step 5 and readjust the position.  

 

              
[Camera screen] 
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7. Check that the red [+] on the camera screen matches the marked [+]. If they do not match, use the 

keyboard arrow keys to fine adjustment the position. Then click [Next]. 

 

              
[Camera screen] 

 

8. The camera automatically recognizes the focus pointer and performs calibration. Wait for the calibration 

to complete automatically. 

✽ Prohibit program and machine operation during automatic calibration. 

When the completion message appears, confirm and complete the calibration. 
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8. Manual calibration 
 

1. Click [Manual calibration] on the machine setting.  

 
 

2. Click the [Edit] button.  
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3. Enter the setting value, then click [Apply] button.   

         
 

4. Select [Correction], the input the number.  

         

7. Click the [Yes] button, then the program will start.  
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9. Import calibration 
1. Click [Import Calibration] on the Machine Setting. 

 
 

2. When you enter the serial number, the correction value stored in the server is automatically called and set. 

✽ This function requires a network connection. 

 

 
 


